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Social Security Online

Replace a Medicare Card

www.socialsecurity.gov Home

Questions? How to Contact Us Search

& Information about Replacing a Medicare Card

oy

If your Medicare card is lost, stolen or damaged, you can ask for a new one at this website.

What is a Medicare Card? .
What You Should Know .
If You Have Moved .

Block access to your
personal information

The Medicare card looks like the red, white and blue card shown here. = ) e

Your Medicare card is your proof that you have Medicare health insurance.  _  Jiiees s

You can use this application only to request a Medicare card. If you need a .u.:';m ’"“4‘%,
Medicaid card, please contact your state Medicaid office. WN&J g
sd
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Your Medicare card will arrive in the mail in about 30 days.

It will be mailed to the address Social Security has on file for you.

If you need proof that you have Medicare sooner than 30 days, you also can request a letter which
you will receive in about 10 days.

If you need proof immediately for your doctor or for a prescription, visit your nearest Social Security
office.

For security reasons, there is a 30 minute time limit to complete each page. You will be given notice
when you are about to time out and can get more time to finish.

You can read more about Social Security's Intemet policy here.

If you have moved and have not reported this to us, you will need to report this change to us befare
We can process your request.

If you have moved and have reported this to us recently, you will need to contact us before we can
process your request.

If you want to prevent enline and automated telephone access to your personal information, you can
block access to yvour personal information.

FIRSTGOV

Privacy Policy | Accessibility Policy | Linking Policy | Site Map
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Social Security Online

www.socialsecurity.gov

Replace a Medicare Card

The Privacy Act Statement

Paperwork Reduction Act

Form Approved: OMB No. 0950-0596
Expires 09/30/2012

/i Public Agreement

N
Social Security provides this website for your convenience.

Sacial Security is allowed to collect the facts on this form under Section 205 of the Social Secunty Act. We
need these facts to quickly identiy who you are and provide the information you requested. Giving us these
facts is voluntary. However, withaut them we may not be able to qive you the information that you want. The
Sacial Security Administration will nat use the information for any other purpose. If you want to read mare
information on this subject, read The Collection and Use of Information from Your Application.

This information collection meets the requirements of 44 U.S.C. § 3507, as amended by section 2 of the
Paperwork Reduction Act of 1995, You do not need ta answer these questions unless we display a valid
(ffice of Management and Budget control number. The OMB control number for this form is 0360-0596,
expiration date 09/30/2012. We estimate that it will take about 10 minutes to read the instructions, gather
the facts, and answer the questions. You may send comments on our time estimate above fo: SSA, 1338
Annex Building, Baffimore, MD 21235-0001. Send only comments on our time estimate to this address,
not the completed form.

By using this website, you agree to its limitations.

Liges



Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

Form Approved: OMB No. 0960-0556
Expires 08/30/2012

To start your request, we need to know who you are. Please provide the following information to identify yourself.

Your Social Security Number:
Use your own number even if you are
receiving benefits as a spouse, child, or
parent under another person's number.

First Name:
Enter Your First Name

Middle Initial:
Enter Your Middle Initial

Last Name:

Enter Your Last Name

Suffix: -
Select a Suffix (if any)

Other Last Name (if any):

For example, your name as shown on a
recent letter from Social Security.

Your Date of Birth:
Month, Day, Year

Have you had a recent change -, Yes ©n
of address that has not been s °
reported to Social Security?




Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

: Reason for Replacement

To complete your request, please indicate why you need to replace your Medicare card. This information is collected for statistical purposes only
and will not affect the processing of your request.

Why do you need a .
replacement Medicare card?




Social Security Online

www.socialsecurity.gov

Replace a Medicare Card

/s, Confirmation
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Thank you !

We received your request for a replacement Medicare card on March 23, 2011.

What You Should Know + You should receive yaur replacement Medicare card by April 22, 2011,
+ It will be mailed to the address Social Security has on file for you.
o Ifyou do not receive it by April 22, 2011, please call us Monday-Friday 7:00 a.m.-7:00
p-m. at 1-800-772-1213 or, if you are deaf or hard of hearing, on our TTY number at 1-
800-325-0778.
Do you need proof of
Medicare sooner? ~ Yes, lwant to request a letter now.

We can mail you a letter as proof of
your Medicare benefits in 10 days. If
you need proof of your Medicare
benefits immediately, contact your
nearest Social Security Office.

© No, 1 don't want to request a letter now.

We suggest you use your browser's *Print” function to print this page for your records.



Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

= Cookies Not Enabled
%, il 7

s

To use this internet application, you must enable "cookies” on your computer. We use "session cookies”
that we store on your computer only during your visit. The session cookie keeps you from losing information
you've entered for a business transaction with us if, during your visit, you leave our website and return.

Once you turn off your computer or stop using the Intemnet, the cookie is erased.
To enable cookies, follow the instructions below for the browser you're using.
Microsoft Internet Explorer 6.0+

Select "Internet Options” from the Tools menu.

Click on the "Privacy” tab.

Click the "Default” button (or manually slide the bar down to "Medium”) under "Settings".
Click "OK".

Microsoft Internet Explorer 5.x

Select "Internet Options” from the Tools menu.

Click on the "Security” tab.

Click the "Custom Level” button.

Scroll down to the "Cookies” section.

Set "Allow cookies that are stored on your computer” to "Enable”.
Set "Allow per-session cookies” to "Enable”.

Click "OK".

Moazilla Firefox (1.0 final release and earlier)

Go to the "Tools” menu.

Select "Options™.

Select the "Privacy” icon in the left panel.

Check the box corresponding to "Allow sites to set cookies”.
Click "OK" to save changes.

Netscape 7.1/Mozilla 5.0

Select "Preferences” from the Edit menu.

Click on the arrow next to "Privacy & Security” in the scrolling window to expand.
Under "Privacy & Security”, select "Cookies."

Select "Enable all cookies”.

Click "OK".

Microsoft Internet Explorer 4.x

¢ Select "Internet Options™ from the View menu.

+ Click on the "Advanced” tab.

+ Scroll down to find "Cookies” within the "Security” section.
& Select "Always accept cookies”.

o Click "OK".

Netscape Communicator 4.x

+ Select "Preferences” from the Edit menu.

+ Find the "Cookies" section in the "Advanced” category.
« Select "Accept all cookies” (or "Enable all cookies”).

¢ Click "OK".

M
2.

Start Over




Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

M How to Report a Change of Address and Request a Replacement Card
You told us you have moved and have not reported this to us. To report your new address and request a
replacement card at the same time, please call or visit Social Security.
To Contact Social Security:

¢ In the United States:

o Call our tollfree number 1-800-772-1213. If you are deaf or hard of hearing, call our toll-free
“TTY" number, 1-800-325-0778. Representatives are available Monday through Friday between
Tam. and 7 p.m.

o Call orvisit your local Social Security office. You can get directions and a map to your local
Social Security Office by visiting the Field Office Locator.

« Qutside the United States, call or visit:
o Your nearest Social Security office,

o The closest U.5. Embassy or consulate, or

o The Veterans Affairs Regional Office (VARO) in the Philippines.

Warning: If you select any of the links above, you will leave this secure site and these pages will open a
new browser window. You will automatically return to this page when you close the new browser window.

SS5A Home



Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

. How to Request a Replacement Medicare Card If You Cannot Request It Online

We're sorry you cannot request a replacement Medicare card online.You must call or visit us to request a
replacement card. If you are —

+ in the United States, you can —-
call us at 1-800-772-1213 Monday through Friday between 7 a.m. and 7 p.m.

call our toll-free TTY number, 1-800-325-0778, if you are deaf or hard of hearing, Monday
through Friday between 7 a.m. and 7 p.m., or

visit your local Social Security office. You can get directions and a map to your local Social
Security Office by visiting the Field Office Locator.

s}

=}
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o outside the United States, you can contact -
o your nearest Social Security office,
o the closest U.5. Embassy or consulate, or

o the Veterans Affairs Regional Office (VARO) in the Philippines.

Warning: If you select any of the links above, you will leave this secure site and go to the copy of these
pages on a new browser. You will automatically return to this page when you close the new browser.

SSA Home



Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

. How to Request a Replacement Medicare Card If You Recently Changed Your
< Address

You told us you have moved and recently reported this to us. To ensure your privacy, you cannot request a
replacement Medicare card online at this time. You must call or visit us to request a replacement card.

To Contact Social Security:
¢+ In the United States:

o Call our toll-free number 1-800-T72-1213. If you are deaf or hard of hearing, call our toll-free
"TTY" number, 1-800-325-0778. Representatives are available Monday through Friday between
7Tam.and 7 p.m.

o Call or visit your local Social Security office. You can get directions and a map to your local
Social Security Office by visiting the Field Office Locator.

o Outside the United States, call or visit:
o Your nearest Social Security office,
o The closest U.S. Embassy or consulate, or

o The Veterans Affairs Regional Office (VARQ) in the Philippines.

Warning: If you select any of the links above, you will leave this secure site and these pages will open a
new browser window. You will automatically return to this page when you close the new browser window.

55A Home
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S e i Replace a Medicare Card

www.socialsecurity.gov

ﬁ?& Information About Time Limits
{:"' \I\l .I, Ih"‘ i

There are time limits for your work on each page. You will receive a warning after 25 minutes, and you will
be able to extend your time on the page. After the third warning on a page, you must move to another page
or your time will run out, and your work on that page will be lost.

If you have turned JavaScript off in your browser, you will not receive any warnings. If you do not go to
another page after 30 minutes, your report session will end, and your work on the last page will be lost.

S55A Home
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Social Security Online

Replace a Medicare Card

www.socialsecurity.gov

Is it safe to transmit
information to the Social
Security Administration over
the Internet?

What is encryption?

Why is special software
necessary to access the
Internet application?

Why SSL?

| have the right software and |
am trying to connect during
your posted business hours,
but | still cannot access your
form. Why?

Jmav Internet Security Policy
W

SSA is taking all reasonable and proper measures, including encryption, to ensure that your personal
information is disclosed only to you. However, the Internet is an open system and there is no absolute
guarantee that others will not intercept the personal information you have entered or requested and
decrypted. Although this possibility is remate, it does exist.

Encryption means that all information relating to you and your account is scrambled and locked with a
mathematical key during the electronic transfer. Most browsers have an icon such as a key or a lock to
represent an encrypted mode or session. A broken key, open lock, or no lock indicates that the session or
mode is not encrypted.

So that your online request can remain confidential, SSA uses a security protocal (method) called Secure
Sockets Layer (SSL) for this application. You must use a Web browser that supports SSL. Netscape
Mavigator and Microsoft Internet Explorer are two browsers that support SSL. Using this security protocol,
all information sent between your computer and our server is encrypted before being sent on the Internet.

SSL provides a high level of security and is the security protocol supported by more browsers than any
other. It is estimated that about 92% of Web browsers have an SSL browser available for their use.

We have found that a number of business, government, and educational networks do not have their firewalls
configured to allow passage of secure Web traffic. Check with your systems administrator to determine if
this is the case at your site. f this is the case you will not be able to access this application web site.

Close this window to continue your request.
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e Replace a Medicare Card

www.socialsecurity.gov

M Our records show you recently requested a replacement Medicare card.
L

You should receive your replacement card in the mail within 30 days at the address we have on record.

If you do not receive your card within 30 days or if you have other questions, please contact Social Security
by telephone on Monday - Friday between 7:00 a.m.-7:00 p.m. at 1-800-772-1213. If you are deaf or hard of
hearing, our TTY number is 1-800-325-0778. You can also contact your local Social Security office.

Back to Social Securty Webste |
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Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

s Railroad Retirement Board Information

Our records show that your Medicare is handled by the Railroad Retirement Board. If you have Medicare
through the Railroad Retirement Board, Social Security cannot issue you a replacement Medicare card.

To request a replacement Medicare card, contact the Railroad Retirement Board. Please call their toll-free
number: 1-800-808-0772, visit the RRB website or contact your Railroad Retirement Board field office.

Back to Social Securty Website |
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S S Replaee a Medicare Card

www.socialsecurity.gov

»s: The Information You Entered Does Not Match Our Records

USA

Please check this + If you typed the wrong information, you will need to correct it before continuing.

information: + Ifthe information is correct, contact Social Security. Be sure to tell the representative that you tried
to complete your request online and received this message.

To contact Social Security: + Call our tollfree number, 1-800-772-1213. Explain that you are unable to complete your request
online. If you are deaf or hard of hearing, call our tollHree "TTY" number, 1-800-325-0778.
Representatives are available Monday through Friday from 7 a.m. to 7 p.m.

+ Go to your local Social Security Office and tell the representative that you were unable to complete
your request.

SSA Home
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Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

m The Information You Entered Does Not Match Qur Records

If the information that you provided is correct, then it may be necessary to corect your Social Security
record.

To resolve the discrepancy: » Call our tollfree number, 1-800-772-1213. f you are deaf or hard of hearing, call our tall-ree "TTY"
number, 1-800-325-0778. Representatives are available Monday through Friday from 7 a.m. to 7 p.m.

« Call orvisit your local Social Security Office.

SSA Home
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S Replaee a Medicare Card

wwnw.socialsecurity.gov

m This Service Is Not Available At This Time
{:"' \I! .I. lh"‘ :

This service is available during the following hours (Eastern Time):

Monday through Friday: 5:00 AM - 1:00 AM
Saturday: 5:00 AM - 11:00 PM

Sunday: 8:00 AM - 10:00 PM

Holidays: 5:00 AM - 11:00 PM

55A Home
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Replace a Medicare Card

Social Security Online

www.socialzsecurity.gov

m Unable to Process Your Request
{:"' \I! .I. l-'-"‘f

If the information you gave us is correct, we're sorry but this semvice is not available to you.

If the information you gave us is correct and you are currently receiving benefits, online access to your
account may be blocked. For assistance, please call us at 1-800-772-1213, Monday through Friday
between 7 a.m. and 7 p.m. If you are deaf or hard-of-hearing, call our toll-free TTY number, 1-800-325-0778,
Monday through Friday between 7 a.m. and 7 p.m.

SSA Home

[ Retum to Online Services
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Replace a Medicare Card

Social Security Online

wWww.socialsecurity.gov

A@T?. We Are Processing Your Request...
% Il 7

......
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e Replaee a Medicare Card

www.socialsecurity.gov

% We Cannot Process Your Request At This Time
o il ¢

Npgpah

We are sorry for the inconvenience but we cannat process your request at this time.

If you still wish to complete your request online, you may try again later. If you want to know about other
options for completing this request you may call 1-800-772-1213 or contact your local Social Security office.
If you are deaf or hard of hearing, call our toll-free “TTY" number, 1-800-325-0778. Representatives are
available Monday through Friday from 7 a.m. to 7 p.m.

S5A Home
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Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

M You Do Not Have Medicare Coverage
5 0 2

Our records show that you currently do not have Medicare coverage. Please see the requirements to receive
Medicare benefits.

If you have any questions, please visit the Medicare website.

If you have ather questions, you can contact Social Security by telephone on Manday - Friday between 7:00
a.m.-7:00 p.m. at 1-800-772-1213 or, if you are deaf or hard of hearing, on our TTY number 1-800-325-0773.
You can also contact your local Social Security office.

Back to Social Security Webste |
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Replace a Medicare Card

Social Security Online

www.socialsecurity.gov

m You Have Reached the Limit on the Number of Requests
We have not been able to match the information you entered with our records.

To resolve the discrepancy: + Call our tollfree number, 1-800-772-1213. If you are deaf or hard of hearing, call our tol-free "TTY"
number, 1-800-325-0778. Representatives are available Monday through Friday from 7 a.m. to 7 p.m.

« Call or visit your local Social Security office.

SSA Home
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S B Replaee a Medicare Card

www.socialsecurity.gov

ﬁ&f‘% Your Session Has Expired
%, 12

We are sorry for the inconvenience but your session has expired.

If you would like to continue completing your request online, you may sign in again by selecting the button
below.

SSA Home

Retum to Request
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